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Warranty and Disclaimer

The use of the deliverables (e.g. software, application examples, target boards, evaluation boards, starter kits, schematics, 
engineering samples of IC’s etc.) is subject to the conditions of Fujitsu Semiconductor Europe GmbH (“FSEU”) as set out in (i) the 
terms of the License Agreement and/or the Sale and Purchase Agreement under which agreements the Product has been delivered, 
(ii) the technical descriptions and (iii) all accompanying written materials.
Please note that the deliverables are intended for and must only be used for reference in an evaluation laboratory environment.
The software deliverables are provided on an as-is basis without charge and are subject to alterations. It is the user’s obligation to 
fully test the software in its environment and to ensure proper functionality, qualification and compliance with component 
specifications.
Regarding hardware deliverables, FSEU warrants that they will be free from defects in material and workmanship under use and 
service as specified in the accompanying written materials for a duration of 1 year from the date of receipt by the customer.
Should a hardware deliverable turn out to be defect, FSEU’s entire liability and the customer’s exclusive remedy shall be, at FSEU´s
sole discretion, either return of the purchase price and the license fee, or replacement of the hardware deliverable or parts thereof, if 

the deliverable is returned to FSEU in original packing and without further defects resulting from the customer’s use or the transport. 
However, this warranty is excluded if the defect has resulted from an accident not attributable to FSEU, or abuse or 
misapplication attributable to the customer or any other third party not relating to FSEU or to unauthorised decompiling and/or 
reverse engineering and/or disassembling.
FSEU does not warrant that the deliverables do not infringe any third party intellectual property right (IPR). In the event that the 
deliverables infringe a third party IPR it is the sole responsibility of the customer to obtain necessary licenses to continue the usage 
of the deliverable.
In the event the software deliverables include the use of open source components, the provisions of the governing open source 
license agreement shall apply with respect to such software deliverables. 
To the maximum extent permitted by applicable law FSEU disclaims all other warranties, whether express or implied, in particular, 
but not limited to, warranties of merchantability and fitness for a particular purpose for which the deliverables are not designated.
To the maximum extent permitted by applicable law, FSEU’s liability is restricted to intention and gross negligence. FSEU is not liable 
for consequential damages.
Should one of the above stipulations be or become invalid and/or unenforceable, the remaining stipulations shall stay in full effect.
The contents of this document are subject to change without a prior notice, thus contact FSEU about the latest one.

This board and its deliverables must only be used for test applications in 
an evaluation laboratory environment.
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Updates and Support
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Download the latest version from the following website:
http://mcu.emea.fujitsu.com/mcu_tool/detail/SK-FM3-176PMC-ETHERNET.htm

Open Questions? Contact:  mcu_ticket.FSEU@de.fujitsu.com

http://mcu.emea.fujitsu.com/mcu_tool/detail/SK-FM3-176PMC-ETHERNET.htm
mailto:mcu_ticket.FSEU@de.fujitsu.com
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Overview

Introduction
About the SK-FM3-176PMC-ETHERNET
SK-FM3-176PMC-ETHERNET box content
SK-FM3-176PMC-ETHERNET CD content
Test it
The hardware
The software

Try yourself
Software examples
Program download
IAR-Embedded Workbench
KEIL µVision
Free open-source Toolchain

Contacts
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Additional documents
Schematic ‘SK-FM3-176PMC-ETHERNET’
Data sheet MB9BD10T Series , Fact sheet
Peripheral Manual

Timer part
Analog Macro part
Communication Macro part
Ethernet part

Errata sheet 
Technical reference manual (r2p0)

revision r2p1
Flash programming manual

Errata sheet 
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About the SK-FM3-176PMC-
ETHERNET

The SK-FM3-176PMC-ETHERNET is a versatile evaluation board based on 
the Fujitsu FM3 microcontroller MB9BD10T Series
The MB9BD10T Series includes the following features:

32-bit ARM Cortex-M3 Core with up to 144MHz operation
Up to 1 Mbyte high-speed  flash memory  with true 72MHz and Flash Accelerator System
Up to 128Kbyte on-chip SRAM memory
Wide supply voltage range from 2.7 to 5.5 V
2 Ethernet - MAC channels 
2 USB interface channels
8 Multi-function Serial Interface channels (for UART, CSIO (SPI), I2C and LIN) 
8 DMA Controller channels
3 12-bit A/D Converters, 1MSp, 32 channels max.
External bus interface
16 Base Timer channels (PWM, PPG, reload or PWV timers selectable)
Up to 154 fast General Purpose I/O Ports
3 Multi-function Timer units(can be used to achieve the motor control)
3 Quadrature Position/Revolution Counter (QPRC) channels
Dual Timer (32/16bit Down Counter)
Resource Pin Relocation
Hardware Watchdog
CRC (Cyclic Redundancy Check) Accelerator
Five dynamically selectable clock sources (2 external oscillator, 2 internal CR oscillator, Main PLL)
Clock Supervisor (CSV)
Low Voltage Detector (LVD) and Low Power Mode

All Rights Reserved.© Fujitsu Limited 2012
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About the SK-FM3-176PMC-
ETHERNET

Features of the SK-FM3-176PMC-ETHERNET board:
Microcontroller MB9BFD18T
2x Ethernet connectors
2x USB-Host (Type-A connector)
1x USB-Device (Type-B connector)
1x USB-to-serial converter (Type-B connector)

• UART and OpenOCD JTAG simultaneously
1x High-speed CAN-Transceiver
1x UART-Transceiver (SUB-D9 connector)
JTAG and Trace Interface each on a 20 pin-header
2x LED-Display (7-Segment)
2x pushbutton (User buttons), rotary encoder, potentiometer
1x Reset-button, Reset-LED
All 176 pins routed to pin-header
On-board 5V and 3V voltage regulators to supply MCU, Power-LED
4x Power supply options: USB, USB-Device, JTAG or external 8V to 12V
Voltage filter for ADC
3x Motor-Control-Interface for e.g. SK-POWER-3P-LV2-MC
TSC-Interface to connect e.g. the Fujitsu SK-TSC-1127S-SB

6
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SK-FM3-176PMC-ETHERNET box 
content

The SK-FM3-176PMC-ETHERNET kit contains
SK-FM3-176PMC-ETHERNET evaluation board with MB9BFD18T
USB cable
CD: Documentation, software examples and development utilities

The SK-FM3-176PMC-ETHERNET kit may be used for test 
applications in an evaluation laboratory environment only!

All Rights Reserved.© Fujitsu Limited 2012
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ESD-foam          ESD-box            SK-FM3-176PMC-ETHERNET           USB cable 
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SK-FM3-176PMC-ETHERNET CD 
content

Software
FUJITSU FLASH MCU Programmer
FLASH USB DIRECT Programmer
FUJITSU USB Assistant
FUJITSU OpenOCD Starter GUI
(including USB driver for on-board USB-to-RS232 converter)

SerialPortViewerAndTerminal

Documentation
Schematic ‘SK-FM3-176PMC-ETHERNET’
Data sheet MB9BD10T Series, Fact sheet
Peripheral Manual

Timer part, Analog Macro part, Communication Macro part
Ethernet part, Errata sheet 

Cortex-M3 Technical reference manual (r2p0), revision r2p1
Flash programming manual, Errata sheet 

Download the latest version from the following website:
http://mcu.emea.fujitsu.com 8

Examples
mb9bfd1xt_template
Further examples are 
available on the CD and on 
our website

Note: 
Please copy the examples 
to your local drive!

All Rights Reserved.© Fujitsu Limited 2012

http://mcu.emea.fujitsu.com/


Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Test it

The microcontroller on the SK-FM3-176PMC-ETHERNET is 
already preprogrammed with a simple application.

Connect the SK-FM3-176PMC-ETHERNET via USB (X11) with the PC
Verify that jumper J5 is in the USBPWR position
Switch SW1 is set to RUN
Press the Reset-button
The SK-FM3-176PMC-ETHERNET will automatically start counting

9
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Test it

You finished successfully the first test

Now you will get more details about the SK-FM3-176PMC-
ETHERNET
You will learn more about 

The on-board features
How to program the Flash
How to start with IAR-Embedded-Workbench and KEIL µVision

10
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Main features: Connectors

The Hardware

All Rights Reserved.© Fujitsu Limited 2012

USB
Device

Ext Power
+8V...+12V

USB to 
UART ‚B‘

USB
Host UART ‚A‘

Keybutton 
‚Reset‘

CANTwin
Ethernet
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Main features: Human Interface

The Hardware
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7-Segment Display

P07_1
P07_6

P07_3

P07_2P07_4

P07_5

P07_0

P05_1
P05_6

P05_3

P05_2P05_4

P05_5

P05_0

P05_7

SEG1: Port50-57    SEG2: Port70-77
P07_7

Keybutton 
‚Reset‘

Keybutton ‚INT11‘
Port P7C

Keybutton ‚INT10‘
Port P7B

LED ‚Power‘

LED 
‚Reset‘

Rotary 
Encoder

Potentiometer
AN30



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Main features: Debugging

The Hardware

13
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JTAG

On-Board JTAG

Trace
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Main features: Other Pin-Headers

The Hardware

14
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Motor Control
Pin-Headers

TSC
(Touch-Sensor Connector)
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The Hardware
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The jumpers: Default Settings
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The jumpers

The Hardware
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Number Description Special Type Default
JP1 Main Clock Oscillator open
JP2 Main Clock Oscillator open
JP3 Main Clock Oscillator open
JP4 Main Clock Oscillator open
JP5 Sub Clock Oscillator open
JP6 Sub Clock Oscillator open
JP7 Sub Clock Oscillator open
JP8 C‐Pin Solder Jumper closed
JP9 C‐Pin Solder Jumper closed
JP10 USB/UART programming open
JP11 Sub Clock Oscillator Solder Jumper closed
JP12 Sub Clock Oscillator Solder Jumper closed
JP13 AVRH closed
JP14 AGND closed
JP15 Main Clock Oscillator Solder Jumper closed
JP16 Main Clock Oscillator Solder Jumper closed
JP17 5V/3V3 1‐2
JP18 MCUVCC closed

Number Description Special Type Default
JP19 SEG1 ‐ P50 Solder Jumper closed
JP20 SEG1 ‐ P51 Solder Jumper closed
JP21 SEG1 ‐ P52 Solder Jumper closed
JP22 SEG1 ‐ P53 Solder Jumper closed
JP23 SEG1 ‐ P54 Solder Jumper closed
JP24 SEG1 ‐ P55 Solder Jumper closed
JP25 SEG1 ‐ P56 Solder Jumper closed
JP26 SEG1 ‐ P57 Solder Jumper closed
JP27 TSC / I2C / SCL‐Pullup closed
JP28 TSC / I2C / SDA‐Pullup closed
JP29 SEG2 ‐ P70 Solder Jumper closed
JP30 SEG2 ‐ P71 Solder Jumper closed
JP31 SEG2 ‐ P72 Solder Jumper closed
JP32 SEG2 ‐ P73 Solder Jumper closed
JP33 SEG2 ‐ P74 Solder Jumper closed
JP34 SEG2 ‐ P75 Solder Jumper closed
JP35 SEG2 ‐ P76 Solder Jumper closed
JP36 SEG2 ‐ P77 Solder Jumper closed



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

The jumpers

The Hardware
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Number Description Special Type Default
JP37 SPI / SIN‐Pin Solder Jumper open
JP38 CAN MCUVCC / VCC5V Solder Jumper 2‐3
JP39 USBVCC0 1‐2
JP40 VBUS USBH0 2‐3
JP41 USBVCC1 1‐2
JP42 USB UHCONX closed
JP43 Rotary Encoder Solder Jumper closed
JP44 Rotary Encoder Solder Jumper closed
JP45 Potentiometer Solder Jumper closed
JP46 VBUS USBH1 1‐2
JP47 FTDI JTAG closed
JP48 FTDI JTAG closed
JP49 FTDI JTAG closed
JP50 FTDI JTAG closed
JP51 UART / SOT USB <‐> RS232 U‐0
JP52 UART / SIN USB <‐> RS232 R‐1
JP53 Flow control open
JP54 CTS4 open

Number Description Special Type Default
JP47 FTDI JTAG closed
JP48 FTDI JTAG closed
JP49 FTDI JTAG closed
JP50 FTDI JTAG closed
JP51 UART / SOT USB <‐> RS232 U‐0
JP52 UART / SIN USB <‐> RS232 R‐1
JP53 Flow control open
JP54 CTS4 open
JP55 MAX3232 VCC Solder Jumper closed
JP56 UART MD0 Solder Jumper open
JP57 RTS open
JP58 UART‐RST open
JP59 Flow control Solder Jumper 1‐2
JP60 Flow control Solder Jumper 2‐2
JP61 Ethernet PHY0 Solder Jumper closed
JP62 Ethernet PHY0 Solder Jumper closed
JP63 Ethernet PHY0 Solder Jumper closed
JP64 Ethernet PHY0 Solder Jumper closed
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The jumpers

The Hardware
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Number Description Special Type Default
JP65 Ethernet PHY0 Reset 1‐2
JP66 Ethernet PHY0 Solder Jumper closed
JP67 Ethernet PHY0 Solder Jumper closed
JP68 Ethernet PHY0 Solder Jumper closed
JP69 Ethernet PHY0 Solder Jumper closed
JP70 Ethernet Clock Enabled closed
JP71 Ethernet Reference Clock Solder Jumper closed
JP72 Ethernet PHY1 Solder Jumper closed
JP73 Ethernet PHY1 Solder Jumper closed
JP74 Ethernet PHY1 Solder Jumper closed
JP75 Ethernet PHY1 Solder Jumper closed
JP76 Ethernet PHY1 Reset 1‐2
JP77 Ethernet PHY1 Solder Jumper closed
JP78 Ethernet PHY1 Solder Jumper closed
JP79 Ethernet PHY1 Solder Jumper closed
JP80 Ethernet PHY1 Solder Jumper closed
JP81 Ethernet VCC 1‐2
JP82 Motor Control 0 Solder Jumper closed

Number Description Special Type Default
JP83 Motor Control 1 Solder Jumper open
JP84 Motor Control 2 Solder Jumper open
JP85 Motor Control 0 Solder Jumper closed
JP86 Motor Control 1 Solder Jumper open
JP87 Motor Control 2 Solder Jumper open
JP88 Motor Control 0 Solder Jumper closed
JP89 Motor Control 1 Solder Jumper open
JP90 Motor Control 2 Solder Jumper open
JP91 Motor Control 0 Solder Jumper closed
JP92 Motor Control 1 Solder Jumper open
JP93 Motor Control 2 Solder Jumper open
JP94 Motor Control 0 Solder Jumper closed
JP95 Motor Control 1 Solder Jumper open
JP96 Motor Control 2 Solder Jumper open
JP97 Motor Control 0 Solder Jumper closed
JP98 Motor Control 1 Solder Jumper open
JP99 Motor Control 2 Solder Jumper open
JP100 Motor Control 0 Solder Jumper closed
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The Hardware

JP51, JP52 : UART selection
UART0 and UART4 of the microcontroller can be used together with a 
standard RS232 SUB-D9 connector and a serial/USB converter
The jumpers JP51 and JP52 routes the channel to the connector
The interface is selected by the jumpers‘ alignment
UART0 = USB-connector (X11), UART4 = Sub-D9 (X12) (default)

• Setting of Jumper JP51 and JP52: U-0 / R-4

UART0 = Sub-D9 (X12), UART4 = USB-connector (X11)
• Setting of Jumper JP51 and JP52: U-4 / R-0

19
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USBRS232

(default)

USBRS232
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Extension headers X20-X23
Standard 0.1” / 2.54mm grid for use with prototype boards

20
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The Hardware
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The Hardware

The microcontroller pins

21

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

1 VCC MCUVCC  12 P09/TRACECLK/TIOB00_2/RTS4_2/DTTI2X_0 RTS/TRACECLK

2 PA0/RTO20_0/TIOA08_0/FRCK1_0
Reset TS C Connector 

/ INT0
13

P50/INT00_0/AIN0_2/SIN3_1//RTO10_0/IC2
0_0/MOEX_0

MotorDrive1 
PWM1H / SEG1‐A

3 PA1/RTO21_0/TIOA09_0/IC10_0 Hall Sensor1‐3 /INT1 14
P51/INT01_0/BIN0_2/SOT3_1/RTO11_0/IC21

_0/MWEX_0
MotorDrive1 

PWM1L /SEG1‐B

4 PA2/RTO22_0/TIOA10_0/IC11_0 Hall Sensor1‐4 15
P52/INT02_0/ZIN0_2/SCK3_1/RTO12_0/IC22

_0/MDQM0_0
MotorDrive1 

PWM2H /SEG1‐C

5 PA3/RTO23_0/TIOA11_0/IC12_0 Hall Sensor1‐5 16
P53/SIN6_0/TIOA01_2/INT07_2/RTO13_0/IC

23_0/MDQM1_0
MotorDrive1 

PWM2L / SEG1‐D

6 PA4/RTO24_0/TIOA12_0/IC13_0/INT03_0 TINT TSC Connector  17 P54/SOT6_0/TIOB01_2/RTO14_0/MALE_0
MotorDrive1 

PWM3H /SEG1‐E

7 PA5/RTO25_0/TIOA13_0/INT10_2 GINT TSC Connector 18 P55/SCK6_0/ADTG_1/RTO15_0/MRDY_0
MotorDrive1 

PWM3L /SEG1‐F

8 P05/TRACED0/TIOA05_2/SIN4_2/INT00_1
UART4 ( RXD)/ 

TRACED0
19

P56/SIN1_0/INT08_2/TIOA09_2/DTTI1X_0/
MNALE_0

MotorDrive1 FAULT 
/SEG1‐G

9 P06/TRACED1/TIOB05_2/SOT4_2/INT01_1
UART4 ( TXD)/ 

TRACED1
20 P57/SOT1_0/TIOB09_2/INT16_1/MNCLE_0 SEG1‐DP

10 P07/TRACED2/ADTG_0/SCK4_2 TRACED2 21 P58/SCK1_0/TIOA11_2/INT17_1/MNWEX_0

11 P08/TRACED3/TIOA00_2/CTS4_2 CTS4/TRACED3 22 P59/SIN7_0/TIOB11_2/INT09_2/MNREX_0

All Rights Reserved.© Fujitsu Limited 2012
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The Hardware

The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

23 P5A/SOT7_0/TIOA13_1/INT18_1/MCSX0_0 34
P36/IC02_0/SIN5_2/INT09_1/TIOA12_2/MCS

X2_0
Hall Sensor0‐5

24 P5B/SCK7_0/TIOB13_1/INT19_1/MCSX1_0 35
P37/IC01_0/SOT5_2/INT10_1/TIOB12_2/MC

SX3_0
Hall Sensor0‐4

25 P5C/TIOA06_2/INT28_0/IC20_1 36 P38/IC00_0/SCK5_2/INT11_1/MCLKOUT_0 Hall Sensor0‐3

26 P5D/TIOB06_2/INT29/DTTI2X_1 MotorDrive2 FAULT 37 P39/DTTI0X_0/ADTG_2 MotorDrive0 FAULT

27 VSS GND 38 P3A/RTO00_0/TIOA0_1
MotorDrive0  
PWM1H

28 P30/AIN0_0/TIOB0_1/INT03_2 QPRC0‐A 39 P3B/RTO01_0/TIOA1_1
MotorDrive0  

PWM1L

29 P31/BIN0_0/TIOB1_1/SCK6_1/INT04_2 QPRC0‐B 40 P3C/RTO02_0/TIOA02_1
MotorDrive0  
PWM2H

30 P32/ZIN0_0/TIOB2_1/SOT6_1/INT05_2 QPRC0‐Z 41 P3D/RTO03_0/TIOA03_1
MotorDrive0  

PWM2L

31 P33/INT04_0/TIOB3_1/SIN6_1/ADTG_6 42 P3E/RTO04_0/TIOA4_1
MotorDrive0  
PWM3H

32 P34/FRCK0_0/TIOB04_1 CANL 43 P3F/RTO05_0/TIOA5_1
MotorDrive0  

PWM3L

33 P35/IC03_0/TIOB05_1/INT08_1 CANH 44 VSS GND
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The Hardware

The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

45 VCC MCUVCC 56 P47/X1A Subclock (optional)

46 P40/TIOA00_0/RTO10_1/INT12_1 57 INTX Key button ‘Reset’

47 P41/TIOA01_0/RTO11_1/INT13_1 58 P48/DTTI1X_1/INT14_1/SIN3_2

48 P42/TIOA02_0/RTO12_1 59 P49/TIOB00_0/IC10_1/AIN0_1/SOT3_2

49 P43/TIOA03_0/RTO13_1/ADTG_7 60
P4A/TIOB01_0/IC11_1/BIN0_1/SCK3_2/MAD

ATA00_0

50 P44/TIOA04_0/RTO14_1 U14 LAN reset ‘nRST’ 61
P4B/TIOB02_0/IC12_1/ZIN0_1/MADATA01_

0

51 P45/TIOA05_0/RTO15_1 U12 LAN reset ‘nRST’ 62
P4C/TIOB03_0/IC13_1/SCK7_1/AIN1_2/MAD

ATA02_0

52 C C‐pin 63
P4D/TIOB04_0/FRCK1_1/SOT7_1/BIN1_2/M

ADATA03_0

53 VSS GND 64
P4E/TIOB05_0/INT06_2/SIN7_1/ZIN1_2/MA

DATA04_0

54 VCC MCUVCC 65 P70/TIOA04_2/MADATA05_0 SEG2‐A

55 P46/X0A Subclock (optional) 66 P71/INT13_2/N8/MADATA06_0 SEG2‐B
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The Hardware

The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

67
P72/SIN2_0/INT14_2/AIN2_0/MADATA07_

0
SEG2‐C / QPRC2‐A 78 P7D/TIOA14_1/FRCK2_1/INT12_0

USB Host‐
Overcurrent 

68
P73/SOT2_0/INT15_2/BIN2_0/MADATA08

_0
SEG2‐D/ QPRC2‐B 79 P7E/TIOB14_1/IC21_1/INT24_0 Hall Sensor2‐3

69 P74/SCK2_0/K8/MADATA09_0 SEG2‐E/ QPRC2‐Z 80 P7F/TIOA15_1/IC22_1/INT25_0 Hall Sensor2‐4

70
P75/SIN3_0/ADTG_8/INT07_1/MADATA10

_0
SEG2‐F 81 PF0/TIOB15_1/SIN1_2/INT13_0/IC23_1

Hall Sensor2‐5 / SIN 
TSC Connector

71
P76/SOT3_0/TIOA07_2/INT11_2/MADATA

11_0
SEG2‐G 82 PF1/TIOA08_1/SOT1_2/INT14_0

SDA1 TSC 
Connector

72
P77/SCK3_0/TIOB07_2/INT12_2/MADATA1

2_0
SEG2‐DP 83 PF2/TIOB08_1/SCK1_2/INT15_0 SCL1 TSC Connector

73 P78/AIN1_0/N9/MADATA13_0
SW Rotary‐A 
/QPRC1‐A

84 PE0/MD1

74
P79/BIN1_0/TIOB15_0/INT23_1/MADATA1

4_0
SW Rotary‐B 
/QPRC1‐B

85 MD0
Programming  
Switch S1

75 ZIN1_0/L9/MADATA15_0 QPRC1‐Z 86 PE2/X0 4MHz Crystal

76 P7B/TIOB07_0/INT10_0 87 PE3/X1 4MHz Crystal

77 P7C/TIOA07_0/INT11_0 88 VSS GND
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The Hardware

The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

89 VCC MCUVCC 100
P1A/AN10/SIN4_1/INT05_1/TIOA13_2/IC00_
1/MAD06_0

Motor Drive1‐
U_PH_B

90 P10/AN00/MCSX7_0
Motor Drive0‐
U_DC_BUS

101
P1B/AN11/SOT4_1/INT25_1/TIOB13_2/IC01

_1/MAD07_0
Motor Drive1‐

U_PH_C

91
P11/AN01/SIN1_1/INT02_1/FRCK0_2/MCS
X6_0

Motor Drive0‐
U_PH_A

102
P1C/AN12/SCK4_1/INT26_1/TIOA14_2/IC02_

1/MAD08_0
Motor Drive1‐
I_DC_BUS

92 P12/AN02/SOT1_1/IC00_2/MCSX5_0
Motor Drive0‐
U_PH_B

103
P1D/AN13/CTS4_1/INT27_1/TIOB14_2/IC03_

1/MAD09_0
Motor Drive0‐

I_PH_A

93 P13/AN03/SCK1_1/IC01_2/MCSX4_0
Motor Drive0‐
U_PH_C

104
P1E/AN14/RTS4_1/INT28_1/TIOA15_2/DTTI

0X_1/MAD10_0
Motor Drive0‐

I_PH_B

94
P14/AN04/SIN0_1/INT03_1/IC02_2/MAD0
0_0

Motor Drive0‐
I_DC_BUS

105
P1F/AN15/ADTG_5/INT29_1/TIOB15_2/FRCK

0_1/MAD11_0
Motor Drive0‐

I_PH_C

95 P15/AN05/SOT0_1/IC03_2/MAD01_0
Motor Drive0‐
I_PH_A

106 AVCC AVCC

96 P16/AN06/SCK0_1/INT20_1/MAD02_0
Motor Drive0‐
I_PH_B

107 AVRH AVRH

97 P17/AN07/SIN2_2/INT04_1/MAD03_0
Motor Drive0‐
I_PH_C

108 AVSS GND

98 P18/AN08/SOT2_2/INT21_1/MAD04_0
Motor Drive1‐
U_DC_BUS

109 VSS GND

99 P19/AN09/SCK2_2/INT22_1/MAD05_0
Motor Drive1‐
U_PH_A

110 PB0/AN16/TIOA09_1/SIN7_2/INT16_0
Motor Drive2‐
U_DC_BUS
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The Hardware

The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

111 PB1/AN17/TIOB09_1/SOT7_2/INT17_0
Motor Drive2‐

U_PH_A
122 P25/AN28/SOT2_1/RTO02_1/MAD16_0

112 PB2/AN18/TIOA10_1/SCK7_2/INT18_0
Motor Drive2‐

U_PH_B
123

P24/AN29/SIN2_1/INT01_2/RTO01_1/MAD1
7_0

113 PB3/AN19/TIOB10_1/INT19_0
Motor Drive2‐

U_PH_C
124 P23/AN30/SCK0_0/TIOA07_1/RTO00_1 Potentiometer

114 PB4/AN20/TIOA11_1/SIN0_2/INT20_0
Motor Drive2‐
I_DC_BUS

125 P22/AN31/SOT0_0/TIOB07_1/ZIN1_1 UART0 ( TXD)

115
PB5/AN21/TIOB11_1/SOT0_2/INT21_0/AI

N2_2
Motor Drive2‐

I_PH_A
126 P21/SIN0_0/INT06_1/BIN1_1 UART0 ( RXD)

116
PB6/AN22/TIOA12_1/SCK0_2/INT22_0/BIN

2_2
Motor Drive2‐

I_PH_B
127

P20/INT05_0/CROUT_0/UHCONX1/AIN1_1/
MAD18_0

117 PB7/AN23/TIOB12_1/INT23_0/ZIN2_2
Motor Drive2‐

I_PH_C
128 PF6/FRCK2_0/NMIX

118 P29/AN24/MAD12_0 129 USBVCC1 USB‐ Power supply

119
P28/AN25/ADTG_4/INT09_0/RTO05_1/MA

D13_0
130 P82/UDM1 USB Data ‐

120 P27/AN26/INT02_2/RTO04_1/MAD14_0 131 P83/UDP1 USB Data +

121 P26/AN27/SCK2_1/RTO03_1/MAD15_0 132 VSS GND
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The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

133 VCC MCUVCC 144 P95/TIOB13_0/RTO25_1/INT27_0/MAD24_0
Motor Drive2‐
PWM3L

134 P00/TRSTX JTAG TRSTX 145 PC0/E_RXER0_RXDV1 U14 LAN RXDV

135 P01/TCK
JTAG TCK / TRACE 
TCK

146 PC1/E_RX03_RX11 U14 LAN RXD1

136 P02/TDI JTAG TDI/ TRACE TDI 147 PC2/E_RX02_RX10 U14 LAN RXD0

137 P03/TMS
JTAG TMC/ TRACE 
TMC

148 PC3/E_RX01/TIOA06_1 U12 LAN RXD1

138 P04/TDO
JTAG TMC/ TRACE 
TMC

149 PC4/E_RX00/TIOA08_2 U12 LAN RXD0

139
P90/TIOB08_0/RTO20_1/INT30_0/MAD19_
0

Motor Drive2‐
PWM1H

150 PC5/E_RXDV0/TIOA10_2 U12 LAN RXDV

140
P91/TIOB09_0/RTO21_1/INT31_0/MAD20_
0

Motor Drive2‐
PWM1L

151 PC6/E_MDIO0/TIOA14_0 U12 LAN MDIO

141 P92/TIOB10_0/RTO22_1/SIN5_1/MAD21_0
Motor Drive2‐
PWM2H

152 PC7/E_MDC0/CROUT_1 U12 LAN MDC

142
P93/TIOB11_0/RTO23_1/SOT5_1/MAD22_
0

Motor Drive2‐
PWM2L

153 PC8/E_RXCK0_REFCK Ethernet clock

143
P94/TIOB12_0/RTO24_1/SCK5_1/INT26_0/
MAD23_0

Motor Drive2‐
PWM3H

154 PC9/E_COL0
Host/Device USB 
switch
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The microcontroller pins (cont‘d)
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Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

Pin Pin‐name
Pin‐Function on 

SK‐FM3‐176PMC‐
ETHERNET 

155 PCA/E_CRS0 USB Host enable 166 PD3/E_TXEN0/TIOB03_2 U12 LAN TXEN

156 ETHVCC Ethernet VCC 167 P62/E_PPS0_PPS1/SCK5_0/ADTG_3

157 VSS GND 168 P61/SOT5_0/TIOB02_2/UHCONX0 USB UHCONX

158 PCB/E_COUT 169 P60/SIN5_0/TIOA02_2/INT15_1
Programming  
Switch S1

159 PCC/E_MDIO1 U14 LAN MDIO 170 PF3/TIOA06_0/SIN6_2/INT06_0/AIN2_1

160 PCD/E_TCK0_MDC1 U14 LAN MDC 171 PF4/TIOB06_0/SOT6_2/INT07_0/BIN2_1

161 PCE/E_TXER0_TXEN1/D7/TIOB06_1 U14 LAN TXEN 172 PF5/SCK6_2/B3/ZIN2_1

162 PCF/E_TX03_TX11/E7/TIOB08_2 U14 LAN TXD1 173 USBVCC0 USBVCC

163
PD0/E_TX02_TX10/SCK4_0/TIOB10_2/INT3
0_1

U14 LAN TXD0 174 P80/UDM0 USB Switch

164 PD1/E_TX01/SOT4_0/TIOB14_0/INT31_1 U12 LAN TXD1 175 P81/UDP0 USB Switch

165 PD2/E_TX00/SIN4_0/TIOA03_2/INT00_2 U12 LAN TXD0 176 VSS GND
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The Software

The SK-FM3-176PMC-ETHERNET CD includes the following 
software:

MCU Flash programming tools
FUJITSU FLASH MCU Programmer for FM3
FLASH USB DIRECT Programmer 

The FUJITSU USB Assistant
The FUJITSU OpenOCD Starter GUI
(including USB driver for on-board USB-to-RS232 converter)
The terminal program SerialPortViewerAndTerminal
Free open-source development toolchain
Software examples for the SK-FM3-176PMC-ETHERNET

Please check our dedicated microcontroller website:

for updates of the Flash programmer tool, utilities and examples
for data sheets, hardware manuals, application notes, etc.

29
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http://mcu.emea.fujitsu.com/
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Source Code Examples

Following examples are provided with SK-FM3-176PMC-ETHERNET for
IAR Embedded Workbench V6.2 and KEIL µVision4:

mb9bfd18t_template-v12
• ‚Empty‘ project as base for user applications

mb9bfd18t_adc_dvm-v10
• Digital voltage meter based on the A/D-converter

mb9bfd18t_uart-v10
• Simple UART example (UART0)

mb9bfd18t_ioport_counter-v10
• Counts from 0 to 99 on the 7-segment display

sk-fm3-176pmc-ethernet_ethernet_uip-v12
• Port of the free µIP (micro-IP) TCP/IP stack including small webserver

Further and updated examples are available on this CD,
our MCU website and our starterkit website.

You can find a demonstration firmware and additional product information
of the commercially supported TCP/IP stack by SEVENSTAX on this CD.

Note: Please copy the examples to your local drive!
30
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http://mcu.emea.fujitsu.com/mcu_product/detail/MB9BFD18TPMC.htm
http://mcu.emea.fujitsu.com/mcu_tool/detail/SK-FM3-176PMC-ETHERNET.htm
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Create own USB Applications

All Rights Reserved.© Fujitsu Limited 2012

31

Using the Fujitsu USB Assistant
Easy to use, step by step
Creates USB Host / Device Projects
Combines microcontroller templates, board support and USB use case
Start installation of Fujitsu USB Assistant
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OpenOCD

OpenOCD (Open On-Chip Debugging) is an open-source 
software, which provides JTAG debugging with GDB

On the SK-FM3-176PMC-ETHERNET is a dual UART-to-USB 
converter that serves two purposes:

JTAG interface to be used with OpenOCD
Virtual COM port

However, this converter chip needs a special driver on the 
connected Personal Computer and for debugging with 
OpenOCD, a GDB (GNU Debugger) server must be started.

FUJITSU OpenOCD Starter GUI is a dedicated application to 
ease the handling with OpenOCD and GDB and a convenient 
way to install all the necessary drivers.

All Rights Reserved.© Fujitsu Limited 2012
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Installation of OpenOCD Debugger

1) Start installation of Fujitsu OpenOCD Starter (GUI)

2) The following window should appear.
Select your preferred language

3) Press Next

33
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4) Select „I accept agreement“ and 
press Next
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Installation of OpenOCD Debugger
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5) Select the installation folder and 
press Next

6) Select Full installation, press 
Next

7) Select shortcuts folder and 
press Next

8) Select „Create a desktop icon“
and Create Quick Launch Icon and 
press Next
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Installation of OpenOCD Debugger

9) Press Install 10) Installation will begin

11) Select Install Drivers and push 
Finish 12) Open the application
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Installation of the USB-driver

Connect the SK-FM3-176PMC-ETHERNET via UARTB (X11) to 
your PC
The Installation of the drivers will be done through OpenOCD. 
Only in case the following dialog box appears, follow the next 
steps.

Windows will tell Found New Hardware: FT232R USB UART and 
the Hardware Wizard should start automatically

• Note: The dialog box may differ with different operating systems

36
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1) Ignore this dialog box
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Installation of the USB-driver
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2) Open OpenOCD
3) Press the button Install Driver

4) If a warning window 
appears, press Continue 
Anyway. This window could 
appear more than once

5) READY!!!! 
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Installation of the USB-driver

Start the Device Manager of the Windows 
Control Panel

START -> Settings -> Control Panel 
Control Panel -> System -> Hardware -> 
Device Manager

Check ‘Ports’ for the assigned virtual COM-
port number

USB Serial Port (e.g.: COM2)

Open the Fujitsu SerialPort Viewer and 
Terminal

Double click on the icon         of the taskbar.

It will show the opened ports, check for the 
assigned virtual COM-port number

USB Serial Port (e.g.: COM2)

All Rights Reserved.© Fujitsu Limited 2012
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Ready!

There are two ways to check whether your installation was successful:
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Flash Programming

There are two options to program the flash:

1. UART Programming (X11, X12)
• Check jumper JP10 is opened
• Connect UART0 of the board to the USB-Port of the PC 

– via USB (JP51, JP52: U-0, R-1)
– via RS232 (JP51, JP52: U-1, R-0)

• Use the FUJITSU FLASH MCU Programmer

2. USB Programming (X7)
• Check jumper JP10 is closed
• Connect the board via USB-Device (X7) to the USB-Port of the PC
• Use the FLASH USB DIRECT Programmer

All Rights Reserved.© Fujitsu Limited 2012
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FUJITSU FLASH MCU Programmer 
for UART Programming

FUJITSU FLASH MCU Programmer
Free of charge, no registration required
Windows based programming tool for FM3 Fujitsu microcontroller
Uses PC serial port COMx (incl. virtual COM port: USB-to-RS232)
Start installation

All Rights Reserved.© Fujitsu Limited 2012
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Program Download

Start the FUJITSU FLASH MCU Programmer
Select the target microcontroller MB9BD18S/T
While MB9BFD18S/T  is not available in the programming tool, MB9BF618S/T can be selected

Select the crystal frequency (4 MHz)
Choose the software example from the example ‘exe‘-folder 
(e.g. .\ \Examples\examples\mb9bfd18t_ioport_counter-

v10\example\IAR\output\release\exe\mb9bfd18t_ioport_counter.srec)

41
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Connect to the PC 
Connect UART0 to RS232 (X12) or
to the USB interface (X11)
Select COM port (‚Set Environment‘)

Open JP10
Set switch S1 to position PROG
Press Reset
Start Full Operation

Program Download

42

(see JP51, JP52 jumper settings) 

RS232   USB port 

S1: Mode selection
PROG: Set switch to position 
‚PROG‘ in order to select the 
program-mode

All Rights Reserved.© Fujitsu Limited 2012

Keybutton ‚RESET‘
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Close the FUJITSU FLASH MCU Programmer
Set switch S1 to position RUN
Press Reset

Program Download

43

S1: Mode selection
RUN: Set switch to position ‚RUN‘
in order to select the run-mode

Keybutton ‚RESET‘

Close the FUJITSU FLASH 
MCU Programmer 

All Rights Reserved.© Fujitsu Limited 2012
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FLASH USB DIRECT Programmer
for USB Direct Programming
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FLASH USB DIRECT Programmer
Windows based programming tool for FM3 Fujitsu microcontroller
Uses direct USB connection (via X7)
Start installation
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Program Download
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Start the FLASH USB DIRECT Programmer
Select the target microcontroller (MB9BFD18S/T)
While MB9BFD18S/T  is not available in the programming tool, MB9BF618S/T can be selected

Choose the software example from the example ‘exe‘-folder 
(e.g. .\ \Examples\examples\mb9bfd18t_ioport_counter-

v10\example\IAR\output\release\exe\mb9bfd18t_ioport_counter.srec)
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Select the MCU power supply (J5)
Close JP10
Set switch S1 to position PROG
Connect USB port X3 with the PC 
Install the USB driver

The driver is in the subfolder driver of installed
programmer
E.g.: C:\FUJITSU USB DIRECT Programmer

Select the COM port 
Press Reset
Start Full Operation

Program Download

All Rights Reserved.© Fujitsu Limited 2012

46

Keybutton

RESET

USB port X7
J5

JP10

S1: Mode selection
PROG: Set switch to position 
PROG in order to select the 
program-mode
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Close the FLASH USB DIRECT Programmer
Set switch S1 to position RUN
Press Reset

All Rights Reserved.© Fujitsu Limited 2012
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Close the FLASH USB 
DIRECT Programmer

Program Download

S1: Mode selection
RUN: Set switch to position RUN in 
order to select the run-mode

Keybutton RESET
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Debugging with OpenOCD
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SK-FM3-176PMC-ETHERNET offers an on-chip debugger via 
USB X11

1. Connect the board on X15 to the USB-Port of your PC
2. Open OpenOCD
3. Select the sk-fm3-176pmc-ethernet in config file
4. Click on Start Debug



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Debugging with OpenOCD

IAR Workbench configuration

1. Open the project you want to debug.
2. Go to Project->Options

All Rights Reserved.© Fujitsu Limited 2012
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3. Select Debugger
4. Select Setup
5. As driver select GDB Server
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Debugging with OpenOCD

IAR Workbench configuration
6. Select GDB Server
7. Type 127.0.0.1 on the field of TCP/IP adress

8. Start debug in IAR Workbench
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The MB9BFD18T microcontroller offers a JTAG-Interface,
which is supported by SK-FM3-176PMC-ETHERNET.

Debug your program with a JTAG-Adapter e.g. Segger J-Link
Connect the J-Link to the JTAG-Interface routed to the 20-Pin-Header 
on X14 and to the USB-Port of your PC
Use IAR-Embedded Workbench to debug your program  
If the JTAG-Adaper allows powering the target, then jumper J5 can be 
set as follows: 

Debugging via JTAG

All Rights Reserved.© Fujitsu Limited 2012
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IAR-Embedded Workbench /
KEIL µVision IDE and Debugger 

All Rights Reserved.© Fujitsu Limited 2012
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Installation
Getting Started
Open Project
Build Project
Debug Project
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IAR Workbench Getting Started

Install EWARM from IAR-CD or download latest version from 
IAR Website

EWARM 30-day Evaluation Version
• http://supp.iar.com/Download/SW/?item=EWARM-EVAL

EWARM 32K Kickstart Version
• http://supp.iar.com/Download/SW/?item=EWARM-KS32

Install J-Link Debugger (SK-FM3-176PMC-ETHERNET-JLINK)
Connect J-Link to USB Port and follow installation instructions

• Drivers:
<Installation_Path>\IAR Systems\Embedded Workbench 
x.y\arm\drivers\Jlink\ x64 or x86

Start EWARM Workbench

All Rights Reserved.© Fujitsu Limited 2012
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http://supp.iar.com/Download/SW/?item=EWARM-EVAL
http://supp.iar.com/Download/SW/?item=EWARM-KS32


Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

IAR Workbench Getting Started
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Choose File → Open → Workspace
Select e.g. \Examples\examples\mb9bfd18t_ioport_counter-
v10\example\IAR\mb9bfd18t_ioport_counter.eww
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IAR Workbench – Main Window
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IAR Workbench
Workspace on left side
of Workbench window

• Choose:
View→Workspace,
if hidden

• Open main.c on 
source files.

Source files on right
side of Workbench
window as tabbed
windows

Project can
alternatively be
opened by:
File→Open→
Workspace→*.eww 
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IAR Workbench – Menu Bar

Menu Bar

All Rights Reserved.© Fujitsu Limited 2012
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File Control 
(new, open, 
save, etc.)

Edit Control
(cut, copy, 

paste, undo, 
redo)

Configuration 
Control

(e.g. RAM or ROM 
debugging)

Navigation Control
(Find, Bookmarks, File 

Navigation, etc.)

Build Control
(compile, make, 

stop build)

Debug Control
(Breakpoint, start 
Debug w/ and w/o 

download)
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IAR Workbench – Workspace
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Project Name

Sub Folder common

Main

Includes

Project Description

Project Built Output
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IAR Workbench – Making Project

Making the Project
Use Make-Icon (      ), <F7> or
Menu: Project→Make
Check for no errors in Output window
below

Build errors are indicated by       or
In Output window and Source view
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IAR Workbench – Download to 
Target

Download to Target and Start Debugging
Use       Icon, <Ctrl>-D, or Project→Download and Debug
A new menu bar will occur on sucessful connection to target
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Reset 
Target

Stop

Step 
Over

Step 
Into

Step 
Out

Next 
Statement

Run to 
Cursor

Run

End 
Debugging

Trace 
Control
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IAR Workbench – Debug (1)

Source Window
The Source windows do not change contents but get additional 
information

• Current line (PC):
• Halted on Breakpoint:
• Halted on Data break (example):  

Disassembly Window
Shows ‘pure‘ disassebly view
Shows mixed mode view
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IAR Workbench – Debug (2)

Watch Window
Watch

• Expressions/Variables have to be added by user and are updated 
by Halt/Breakpoint

Quick Watch
• The Quick watch allows the user to calculate and recalculate 

expressions even with variables

• The drop down menu memorizes the last typed contents
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IAR Workbench – Simulator

Simulator
Mark Project File in Workspace
Choose Project→Options
Choose Simulator in Debugger Setup
Start Simulator with usual      Icon
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KEIL µVision IDE and Debugger 
Getting Started
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Install µVision from KEIL-CD or download latest version from 
KEIL Website

Evalualtion Version
• https://www.keil.com/demo/eval/arm.htm
• Registration required

Install ULINK-ME 
Specical installation is not needed, because ULINK-ME acts as a USB 
Human Interface Device (HID) and thus needs no extra USB driver

Install ULINK Pro (optional)
ULINK Pro needs an own dedicated USB driver located in:
<Installation Path>\KEIL\ARM\ULINK

Start µVision

https://www.keil.com/demo/eval/arm.htm
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KEIL µVision – Getting Started

Choose Menu: Project→Open Project...
Browse to: \Examples\examples\mb9bfd18t_ioport_counter-
v10\example\ARM\
Choose mb9bfd18t_ioport_counter.uvproj
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KEIL µVision – Main Window

KEIL µVision
Project window on left side of
IDE window

• Choose:
View→Project Window
if hidden

Source files on right side
of IDE window as tabbed
windows
Output window on bottom
side of IDE window
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KEIL µVision – Menu Bars (1)

Menu Bar 1
Can be moved in bar window area or set floating
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File Control
(new, open, 
save, etc.)

Edit Control
(cut, copy, paste, etc)
(indention, commenting)

Navigation Control
(Bookmarks + search, etc.)
(Text search, search in files, etc.)

Debug Control
(Start/Stop Debug Session, 
set/remove/disable 
breakpoints, remove/disable 
all breakpoints)

Project 
Window View

IDE 
Configuration
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KEIL µVision – Menu Bars (2)

Menu Bar 2
Can be moved in bar window area or set floating
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Build Control
(Compile [Translate], 
Build, Rebuild, etc.)

Download 
to Target

Configuration 
Control
(e.g. RAM or ROM 
debugging)

Target 
Options

Manage Books, 
File Extensions, 
Environment

Manage 
Multi-
Project 
Workspace
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KEIL µVision – Project Window

µVision Project Window
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Project Name

Startup Code Subfolder

Startup Code Source and 
HeaderFiles

Main Project Code Subfolder

Main Project Code Source and 
Header Files

Project Description Subfolder 
and Abstract File

All Rights Reserved.© Fujitsu Limited 2012
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KEIL µVision – Making Project

Making the Project
Use Rebuild Icon
(      ) or
Project→Rebuild all target
files
Check for no errors in
Output window below

Build errors are shown in Output window.
• Can be double-clicked by showing the source line with a blue arrow
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KEIL µVision – Debug (1)

Start Debugging
Download to target first, when MCU Flash does not contain the current 
application openend and built in the IDE

• Use Download Icon (      ) or Menu: Flash→Download
Start Debug Session

• Use Start/Stop Debug Icon (       ) or Menu: Debug→Start/Stop 
Debug Session

Ending Debug Session
• Use same way as for starting debug session
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KEIL µVision – Debug (2)

Debugging Icon Bar
During a Debug Session there will be visible a new icon bar
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Reset 
Target

Start/
Stop
Application

Step Control 
(Step in, out, 
etc.)

Show 
Source/Code 
Line of current 
PC

Show Windows 
(Command, Disassembly, 
Symbols, Registers, Call Stack)

Show (multiple) 
Windows
(Watch, Memory, Serial, 
Analysis, Trace, System 
Viewer)

Tool Box 
(can be 
customized)

Debug 
Restore 
Views
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KEIL µVision – Debug (3)

Source View
The Source windows do not change contents but get additional 
information
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Active Breakpoint

Disabled Breakpoint

Current Program 
Counter

Current Cursor Line of 
Source Code

Code Lines with 
compiled Instructions 
(dark grey    )
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KEIL µVision – Debug (4)

Disassembly View
Mixed mode is selectable and deselectable
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Active Breakpoint

Disabled Breakpoint

Current Program 
Counter

Current Cursor Line of 
Code highlighted in 
yellow background (   )
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KEIL µVision – Debug (5)

Memory Window
Up to 4 Memory windows can be displayed in tabs
Memory is updated during runtime
Memory window tabs are shared with Watch windows

Register View
Register view is a tab of the Project window
Changes are highlighted in dark blue text
background
Register tree knots can be expanded
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KEIL µVision – Debug (6)

Variable Windows
Watch Windows

• Up to 2 Watch windows are sharing their tabs with e.g. Memory and 
Local views

• Updated during runtime
• Any changes are highlighted in dark blue text backround color
• Displayed values can be changed by user during break

Local View
• The local view shares the tab with e.g. Memory and Watch windows
• Any changes are highlighted in dark blue text backround color
• Displayed values can be changed by user during break

75
All Rights Reserved.© Fujitsu Limited 2012



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

KEIL µVision – Trace (ULINK ME)

Trace via ITM
Simple Trace views via Instrumentation Trace Macro is supported by 
µLINK ME

• Records
• Exceptions
• Counters
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KEIL µVision –
Trace (ULINK Pro) (1)

Trace via ETM
Check settings in menu:
Flash→Configure Flash Tools... Tab:Debug
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enables ETM pins
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KEIL µVision –
Trace (ULINK Pro) (2)

Instruction Trace
Real Time Trace recording
Output can be filtered by several ETM and ITM events
Trace buffer is held in PC memory and transfered to µVision on break
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KEIL µVision – Simulator

Simulator
The Core Simulator can be selected by the menu:
Flash→Configure Flash Tools... and then choosing Use Simulator
Look & feel is like using ULINK debugger
Controlable also by*.ini files
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Free open-source toolchain

To setup and use a development toolchain based on free 
licensed open-source tools, please see our application note 
300403: GNU Tool Chain for FUJITSU Cortex-M3 MCUs

For new versions of this document, please check our website and 
search for 300403 or GNU

For further support, please consult directly the respective 
developers and official project websites:

Eclipse IDE
YAGARTO – Yet another GNU ARM toolchain
OpenOCD – Open On-Chip Debugger
please notice our OpenOCD Starter GUI that eases driver handling

All company and product trade marks and registered trade marks used throughout this literature are acknowledged as the property of their respective owners.

All Rights Reserved.© Fujitsu Limited 2012
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http://mcu.emea.fujitsu.com/mcu_product/mcu_all_appnotes.htm
http://www.eclipse.org/
http://www.yagarto.de/
http://openocd.sourceforge.net/
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Further Steps

In order to learn more about Fujitsu’s microcontrollers

Visit our microcontroller website
• http://mcu.emea.fujitsu.com
• http://mcu.emea.fujitsu.com/mcu_product/detail/MB9BFD18TPMC.htm

See our application notes
• http://mcu.emea.fujitsu.com/mcu_product/mcu_all_appnotes.htm

See our software examples
• http://mcu.emea.fujitsu.com/mcu_product/mcu_all_software.htm

Contact your local distributor …

for individual support
to register for our monthly FM3 seminar  
to get the latest Fujitsu Micros DVD containing all information regarding 
Fujitsu’s 8-bit, 16-bit, and 32-bit microcontrollers
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Seminars

FM3 Seminar Motion Control Workshop USB Workshop

free of charge

1 day – once per month 1 day 2 days
• Overview FM3 processor family
o Memory 
o Peripheral resources 
o Packages 

• Processor architecture 
o Bus structure 
o Flash memory 
o Flash programming methods 

• Peripheral resources 
o Clock distribution 
o Timer 
o Interfaces 
o FM3 features 

• Development tool chains 
o IAR workbench, J-Link adapters 
o KEIL uVision, uLink adapters 
o Starter Kits 

• Practical exercises 
o Flash programming 
o Project setup and modification 
o Debugging 
o External interrupts 

1. Introduction of Fujitsu MCU 
a. Line-Up of microcontrollers with motion control 

features 
b. Performance 

2. Introduction of motors types 
a. ACIM            b. BLDC              c. PMSM 

3. Introduction of common control types 
a. Sinusoidal commutation 
b. Field Orientated Control 
c. Space Vector Modulation 

4. Peripherals for motion control based on FM3 
devices 

a. Base Timer 
b. Multifunction Timer 
c. 12-bit A/D Converter 
d. Quad Position & Revolution Counter 
e. Interrupt Controller 

5. Hands-on exercise 
a. Software example for a BLDC motor with hall 

effect sensor 
b. Software example for a field orientated control 

of a PMSM motor 

Introduction 

USB vs. RS232 
Historical Background 

Electrical Layer 

USB Protocol 
Enumeration Process (Descriptors & USB 
Settings) 
Transfer Types & Data Transfers 
USB Class Concept 

Software Driver Concepts 
USB Host in Embedded Systems 

USB Examples: Start with Virtual COM Port 
Using Fujitsu USB Descriptor Manager to create 
Template Classes & Descriptors 

PC Software programming using LibUSB with 
Windows 

Special Use Cases (e.g. boot loader) 
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For current information, please refer to http://www.fujitsu.com/emea/services/microelectronics/trainings/index.html

Inverter Control

http://www.fujitsu.com/emea/services/microelectronics/trainings/index.html
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Microconsult
• http://www.microconsult.com/english/training/description/e-CORTEX.shtml

Cortex™-M3 (ARM): Architecture and Embedded Programming
• Cortex™-M Processor Architecture
• Register organization, Special Purpose Register, Operation Modes, Stacks, 

Pipeline concept, Bit Banding
• ARM Processor Cores - Overview (Cortex M0, M1, M3, M4, R4, A8, A9)
• Cortex™-M Instruction Set 
• Exception and Interrupt Handling 
• Reset Modes, Clock Generation, Power Management, Memory Interface 
• Embedded Core Debugging 
• Efficient C Programming for Cortex Architectures / Hardware-near C 

– Interface C - Assembler
• Practical Exercises with Keil µVision and ARM RealView Tools 

Please contact Fujitsu to get

Trainings

http://www.microconsult.com/english/training/description/e-CORTEX.shtml
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Contacts - Distribution

European distributors

Anatec                                        www.anatec.ch
EBV Elektronik                          www.ebv.com
Farnell                                        www.farnell.com
Glyn                                            www.glyn.de , www.glyn.ch
Ineltek                                         www.ineltek.com
Melchioni Electronica               www.melchioni.it
PN Electronics                           www.pne.fr
Rutronik Elektronische             www.rutronik.com
Bauelemente
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Fujitsu Semiconductor Europe

http://www.fujitsu.com/emea/contact/microelectronics/salesoffices/

Germany (Headquarters)
63225 Langen Tel: +49 (0) 61 03 69 00

France
91300 Massy Tel: +33 (0) 1 64 47 97 00

Italy
20080 Milano Tel: +39 02 90 45 02 1

United Kingdom 
Maidenhead Tel: +44 (0) 1628 50 46 00

Hungary
1143 Budapest Tel: +36 1 471 21 29

Turkey
34180 Istanbul Tel: +90 212 557 18 81

World Wide Web
http://emea.fujitsu.com/microelectronics
http://mcu.emea.fujitsu.com
Contact:  mcu_ticket.FSEU@de.fujitsu.com
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EU-Konformitätserklärung /
EU declaration of conformity

Hiermit erklären wir, Fujitsu Semiconductor Europe GmbH, Pittlerstrasse 47, 63225 Langen, Germany
dass dieses Board aufgrund seiner Konzipierung und Bauart sowie in den von uns in Verkehr gebrachten 
Ausführung(en) den grundlegenden Anforderungen der EU-Richtlinie 2004/108/EC „Elektromagnetische Verträglichkeit“
entspricht. Durch eine Veränderung des Boards (Hard- und/ oder Software) verliert diese Erklärung ihre Gültigkeit!

We, Fujitsu Semiconductor Europe GmbH, Pittlerstrasse 47, 63225 Langen, Germany 
hereby declare that the design, construction and description circulated by us of this board
complies with the appropriate basic safety and health requirements according to the EU Guideline 2004/108/EC entitled 
’Electro-Magnetic Compatibility’. Any changes to the equipment (hardware and/ or software) will render this declaration 
invalid!

Note:
This evaluation board is a Class A product according to EN61326-1.
It is intended to be used only in a laboratory environment and might cause radio interference when used in residential
areas. In this case, the user must take appropriate measures to control and limit electromagnetic interference.

All data and power supply lines connected to this starter kit should be kept as short as possible, with a maximum 
allowable length of 3m. Shielded cables should be used for data lines. As a rule of thumb, the cable length used when 
connecting external circuitry to the MCU pin header connectors for example should be less than 20cm. Longer cables
may affect EMC performance and cause radio interference.

All Rights Reserved.© Fujitsu Limited 2010
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Recycling

Gültig für EU-Länder:
Gemäß der Europäischen WEEE-Richtlinie und deren Umsetzung 
in landesspezifische Gesetze nehmen wir dieses Gerät wieder zurück.
Zur Entsorgung schicken Sie das Gerät bitte an die folgende Adresse:

Valid for European Union Countries:
According to the European WEEE-Directive and its implementation 
into national laws we take this device back.
For disposal please send the device to the following address:

Fujitsu Semiconductor Europe GmbH
Warehouse/Disposal 

Monzastraße 4a
D-63225 Langen

This board is compliant with China RoHS
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